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Abstract

In Cosmological Physics today, theoretical study and numerical simulations dominate
over observation. With the vast arrays of physical and technological barriers to make
cosmologically significant observations, theories and hypotheses are tested primarily
on their confirmability with the small and limited astrophysical data available. The
lack of data pertaining to the cosmological scale and the heavily coupled partial
differential equations normally associated with cosmological physics require numerical
simulation and superb data visualization tools. Furthermore, since it is implausible
to do any kind of experimentation in a laboratory setting to distinguish between
cosmological theories, numerical simulation remains to be the only viable solution to
take on that task by deducing from the 'digital' universes, which model best fits all
available cosmological data. Recent space based observatories, such as the Microwave
Anisotropy Probe (MAP), and ambitious new ways of looking at the universe through
gravitational-wave detection will expose many features of the universe and narrow
down the long list of plausible cosmological models. This thesis briefly discusses
various numerical simulations and data visualization tools, and presents a detailed
case study of a numerical simulation and data visualization tool, dubbed QuintET,
developed for the study of quintessence cosmological models.

Thesis Supervisor: George A Kocur
Title: Senior Lecturer
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Chapter 1

Introduction

For a very long time and even today physicist at leading institutes and national

labs use procedural programming languages, such as FORTRAN, to carry out their

numerical calculations and data analysis. Although still very popular, these environ-

ments do not scale up to the challenges of today's particle accelerators and numerical

calculation needs. Today, there are over a dozen of experiments that produce over

a Terabytes of raw data per run, and the complexity of the data analysis scheme

required for such a large volume of data demands a transition to modern software

development tools and practices.

The progress made in Computer Science over the last two decade, particularly

in the area of Object-Oriented design and development, allowed for the development

of large-scale data analysis tools such as ROOT [4], Matlab [9], etc. Furthermore,

Object-Oriented programming allowed for the development of complex data analysis

and numerical calculation tools with a relatively short development time.

QuintET, the numerical calculations and data visualization tool I developed and

discuss in this thesis, is designed for the study of cosmological models. Before going

straight to discussing the software, I will first present the necessary background needed

to understand what the system does. The appendices present a step by step derivation

of the main equations behind quintessence.
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Chapter 2

Quintessence

2.1 Background

'Until about the early 1900s, most scientist thought that we live in a static universe.

When Albert Einstein first applied his General Theory of Relativity in 1917 to the

universe as a whole, he realized that a static solution to his equation did not exist.

According to the general theory of relativity, the gravitational force between material

objects is always attractive. Einstein realized that by adding a repulsive term, which

he called the cosmological constant (A), his equation allows for a static universe

solution.

After Edwin Hubble's convincing demonstration in the 1920s that the universe is

expanding, Einstein quickly discarded his cosmological constant, calling it his greatest

blunder. Hubble's observation strongly suggest that distant galaxies are receding from

us with a velocity that is proportional to their distance. Thus one can write

v = Hr,

where v is the recession velocity, r is the distance to the galaxy and H is the Hubble

constant.

'Some of the work presented here is taken from my research in cosmological physics with Professor
Alan Guth, Department of Physics, Massachusetts Institute of Technology.
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If the universe is expanding according to the Hubble's Law, then one can extrap-

olate the expansion backwards in time to an instant when all the galaxies must have

been at the same point and the universe would have an infinite density. Current

estimates put that instant, dubbed the Big Bang, about 10 to 20 billion years ago.

In addition to Hubble's law, much observational evidence was found in support of

the big bang theory. Two important pieces of evidence are the Cosmic Background

Radiation (CMB) and the big bang nucleosynthesis. Despite of its success in ex-

plaining the evolution of the universe since about one second after the big bang, the

standard big bang model leaves very obvious questions unanswered. The initial con-

ditions of the big bang look peculiar and are assumed without any explanation. The

following list encapsulates the main problems with this theory.

The Horizon Problem How did the universe become so homogeneous on large

scales? The horizon at last scattering (Z ~ 1000) subtends an angle about

one degree. How did then universe, which largely consists of causally discon-

nected regions, became homogeneous on large scale?

The Flatness Problem Why was the mass density of the early universe so extraor-

dinarily close to the critical density-equal up to the fifteenth decimal place?

The Structure Problem The universe is not precisely homogeneous. This model

does not give an explanation for the origin or the form of these inhomogeneities.

The Expansion Problem What caused the initial expansion of the early universe?

In rescue of the big bang theory came a new theory, which is a blend of parti-

cle physics-the physics of elementary particles, governed by quantum theory-and

cosmology-the physics of space-time and energy, governed by relativity theory. The

mechanism of this new theory, the Inflationary Theory, which was first proposed by

Alan Guth in 1981, depends on scalar fields.

As technology progresses, new and improved methods of probing the far reaches

of the universe becomes possible. Early supernovae study suggest that supernovae

could be used as standard candles for cosmological measurements [7]. In the late

16



1980s, with the discovery of a more homogeneous subclass of type Ia supernovae [7],

determination of cosmological parameters became feasible. The Supernova Cosmology

Project, started in 1988 [7], specially made it possible to measure supernovae events

with a high-redshift enough to determine cosmological parameters of the universe

such as the deceleration parameter. Analysis of recent observations by [7] and other

groups suggest that the expansion of the universe might be accelerating. Furthermore,

preliminary analysis of data from MAP suggest that the equation-of-state of the

universe is negative (i.e. the universe is permeated with an exotic form of matter

that produces a long-range repulsive gravitational force). If these observations are

true, and most scientist agree they are, then a good fraction of the energy content

of the universe must have negative pressure. Currently, there are two explanations.

One is a none-zero cosmological constant, and the other is that the universe is being

accelerate by the gravitational repulsion caused by Quintessence-a slowly evolving

scalar field that permeates the universe.

Quintessence not only beautifully solves the accelerating expansion problem, but

also addresses the coincidence problem that the none-zero cosmological constant sce-

nario does not address.

As the universe expands, the energy density associated with the different con-

stituent elements (photon, neutrino, baryonic matter, cosmological constant and/or

quintessence, etc.) evolve in different rates. This fact in conjunction with observa-

tions, require that the ratio of the energy density of the element that is responsible

for the accelerated expansion to that of everything else must be set to a specific,

infinitesimal value in the early universe. This problem is avoided under a subclass of

quintessence that allow for tracking solutions.

The mathematics of this model of quintessence, dubbed "tracker field," is explored

in appendices (A), (B) and (C). In the following few sections, I will quote the equations

required in QuintET and modify them to allow for numerical calculations.

17



2.2 Governing Equations

From appendices (B) and (C), only equations ( B.25), ( B.26) and ( C.9) are required

to carry out quintessence calculations. In order to carry out numerical calculations,

however, we need to modify these equations so that unitless variables are obtained.

After setting ~ 0, these equations give:

H 2  ( ) = -G(PT), (2.1)
(R 3

= - - G(pT + 3pT), (2.2)

+ 3HO + dV/dQ = 0, (2.3)

where Q has been substituted in place of <$, and pT and pT are the total energy

density and pressure densities of the universe as given by Too (equation ( B.19)) and

Til (equation ( B.24)) terms, respectively. It is believed that the energy content of

the universe is primarily composed of quintessence, cold-dark matter (or ordinary

matter), radiation, and neutrino. Furthermore, the energy density of ordinary matter

scales as pm oc R-, and that of radiation scales as py oc R-4 . Assuming neutrinos are

massless, the neutrino energy density pi, also scales as that of radiation. Therefore,

the time dependency of these energy densities could be written as:

A= R(t) Pi'O (2.4)

where i is anyone of m, -y, or v; and j is the appropriate power dependency. Subscript

"a" refers to any reference time2. With the following definitions

3H 2 p
PC _ , and 7-, (2.5)81rG' PC

2The reference time is chosen based on available observational data or theoretical prediction
that determine one or more cosmological variables, such as the energy densities, with some level of
confidence. It is also when the redshift, Z, is zero in this model. In this thesis, the reference time is
assumed to be the current era where Qm :::::: 0.3. The numerical simulation package developed allows
for this value to vary.

18



equation (2.4) can to rewritten as

P o i [R (t 0) 1A = PC[J~i'" R(t) . (2.6)

We now define the main unit-less quantity x in this calculation as

R(t)X =- .t (2.7)R(to)'

Therefore equation (2.1) can be rewritten as

( H02 {Q",X-4 + Q ,0 - 4 + 3m,oX + ± ( ,

where OQ = pQ/pc,o. The above equation could also be rewritten as follow in order

to make the first derivative of x more transparent:

H4
= [nQ (t) X4 + Qm,OX + ',+V,0] . (2.8)

Furthermore, if the above equation is evaluated at t = to, we obtain Q+m+y+v = 1,

as required for a flat universe3 . QuintET employs Taylor expansions to carry out the

numerical calculation; hence, by taking the derivative of equation (2.8), we obtain an

expression for the second derivative of x:

.. 1 (H 0 \ 2  X3 + [ H )2 dVX= A)( x3 + Qm,o) - 2Hj ± + (+Hx)2  [dQ . (2.9)

With this results, we are now set to carry out the calculation. Since the equations

described above are two non-linear second-order coupled differential equations, we

need to set a few initial conditions on x (x and ± for instances) and and on Q (similarly

Q and Q). Furthermore, some quantities, such as the current value of Hubble's

constant, the current background energy densities, the current critical energy density

of the universe must be set. Finally, V[Q] also must be fixed to have a specific form.

3In accordance with the inflationary theory and observation, in all calculations the background
space-time is assumed to be given by the flat (k = 0) Robertson-Walker metric.

19



2.3 Parameters and Initial Conditions

QuintET is equipped to handle the following form for the potential energy:

Va[Q] = M 4 ( ), (2.10)

where M is the only free parameter and Mp = 1.22 x 1019 GeV is the Plank mass and

a is an integer greater than one. These potentials allow for a tracker solution [15].

Furthermore, we can also construct an exponential potential from these by summing

all powers of a, as follows:

V[Q]M 4 [exp ( -1]. (2.11)
a=1 L

The single most important parameter in cosmology is perhaps the Hubble's con-

stant, which measures how fast galaxies are receding away from us. Its value today

is estimated to be

Htoday = Hoh x (9.78 x 10 9 yr)- 1,

where h is the Hubble parameter and estimated to lie between 0.4 and 1 [8]. Using

equation (2.5) and the above result, one obtains

Pc,O = Pc(to) = 8.03 x 10- 47h 2 GeV 4.

With the critical energy at t = to determined, solving for either the omegas or the

energy densities is exactly the same. Therefore we use Q+m++-v = 1 to eliminate

one parameter and obtain the values for remaining three energy densities.

Black-body electromagnetic radiation has an energy density given by

) r2 [KT(t)]4

p~t) = ,5h) (2.12)15(hC)3

where K is the Boltzmann's constant. Since we know from the thermal cosmic back-

ground radiation that the universe 'glows' at a temperature 2.735K [6], we can use

20



equation (2.12) to calculate the photon energy density, and subsequently Q',O. Putting

this value for temperature in equation (2.12) and using (2.5) we obtain

Q Y= 1.0 x 10-4.

Furthermore, the decoupling of neutrinos preceded the decoupling of photons in the

early universe. Using the decoupling temperature of neutrinos and photons, one can

infer the ratio of their temperature must satisfy

4 )13 T

Using the observed photon temperature today, we can deduce the existence of a

neutrino background with temperature T, = 1.95K. Using equations (2.5) and (2.12)

we get

Qv, o = 2.6 x 10-5.

One free parameter whose value must be determined is M. If Om,o ~ 0.3,
as astronomical observation suggest, Q,o = QT-(m+-y+,) ~ 0.7. Here is where

we must fine-tune the only free parameter M in our equations in order to ob-

tain the desired QQ,o value (4 0.7). In the numerical calculations, this was done

by first estimating the value of Q and Q, hence pQ,O, at some reference time then

recursively adjusting M until the desired result is obtained. To get an order-of-

magnitude estimation, we can proceed as follows. In order to get QQ, 0 ~ 0.7 requires

V(Q e MP) ~ Pm,o = Qm, 0 X Pc,o [15]. This imposes the constraint

m4 ( Qm, o x PC'O ~ 10-48 (GeV) 4.

2.4 Algorithm

In order to employ numerical methods, as discussed above, it is necessary that we fix

the initial conditions. One can see that there are only three independent variables in

21



these equations; hence setting x(ti), Q(ti) and Q(ti), where i stands for initial and

not the reference time, suffices to numerically solve the coupled differential equations

and obtain numerical estimates of all the relevant quantities. The initial values of

Q and pQ are only limited by the range of initial conditions the quintessence model

permits. A weak constraint consists of pQ,i must be large enough but smaller than

the background energy density so that Q begins tracking today. The following is an

example of initial conditions used:

* x(t,) = 1 x 10-14,

" Q(ti) = 2.17 x 1017 GeV, and

* Q(t,) = 1 x 0-30 (GeV)2.

As you will see in the next chapter, it is possible to manually and systematically

change these values in QuintET.

The numerical calculation was carried out by calculating the first few orders of

x, Q and Q in Taylor expansion with higher order correction terms. Since the rate

of change of x varies greatly for the 1/x > 1 and 1/x < 1 eras, the time division

dt also varied as well. In QuintET, this was set as dt = 1 0logxlog-3. Therefore, a

thousand calculations were done for each order of x. In turn, x varied from about

10-20 to 10380, which roughly results in 300, 000 times number of variables calculated

data points per run. This is an enormous memory load.

Taking x as an example, the following steps illustrate how the numerical integra-

tion was carried out:

1. ,k(i) (from equation (2.8))

2. , (i) (from equation (2.9))

3. x(i + 1) = x(i) + 1(i)dt + lij(i)dt2 (first approximation)

4. k(i + 1) (from equation (2.8))

5. ,(i + 1) (from equation (2.9))

22



6. x(i + 1) = x(i) + v(i)dt + i(i)dt2 + a ( dt ) dt3 (final approximation)

Since 1/(Z + 1) equivx > 0, therefore Z + 1 > 0, numerical calculations were

terminated when 4 Z = -1.

4Due to the nature of floating-point calculations, the calculation in fact stopped when Z + 1 ~
10-308.
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Chapter 3

QuintET

QuintET features tools to numerically calculate cosmological parameters as well as

an elaborately designed data visualization tool to help analyze cosmological data.

QuintET is developed using the Java 2 SDK 1.4. The primary packages used along

with their descriptions are given in table (D.1). The following few sections will briefly

discuss the different aspects and features of QuintET.
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3.1 Design

3.1.1 Design Structure

QuintET is design with modularity in mind 1 . The TabbedQuint Frame class acts like

a hub where each of the different engines (calculation, plot, etc.) and components

(help, menu, etc.) plug-in. Overall, the application has 23 primary classes and 2

interfaces. The total number of classes including inner classes exceeds 100. The

application has a centralized serializable preferences class where calculation and

plot settings (discussed below) as well as general user preferences (such as option to

zip saved files) are stored. The following is a brief discussion of the two main classes

that handle numerical calculation and data plotting behind the scene.

calculationThread This class, which runs on a separate Thread, is used by the

calculation engine which is part of the calculation component. This particu-

lar component, along with its classes (calculationThread is one of them) is

designed specifically for quintessence calculations. Other components that do

other calculations can be added as discussed below. The data generated is

stored in a class that extends the Iplottable and the Iexportable interfaces

so as to allow for the plotting and saving, respectively, of the data.

drawingArea The drawingArea class, which also runs on a separate Thread, is part

of the plotting component. This component, along with all of its classes, is de-

signed to handle any data that implements the Iplottable interface (discussed

below) irrespective of its source.

3.1.2 Data Format: Inheritance

One features of QuintET's modular design that deserves special treatment is the data

format. The two interfaces in the application, namely Iexportable and Iplottable,

determine if a data has the correct format to be displayed or/and to be plotted. The

'Please refer to figure (3-1) throughout this section
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data set that is handled by the data displaying component and the data plotting com-

ponent must implement the Iexportable and Iplottable, respectively. Amongst

other features, each plottable data set must contain a method to sample its content

given a density parameter.

3.1.3 Extensibility

The data plotting and displaying components make no distinction whether the data

is obtained from a calculation or was imported from a file as long as the specified

format is met. Therefore, these two components could be used in a number of ways.

For instances, a component that carries out market analysis calculation can be im-

plemented conveniently to use the data displaying and plotting (along with data and

plot saving, etc.) capabilities of these two components.

Furthermore, as discussed above, these components plug-in to the hub in a fairly

straightforward manner. Therefore, additional components can be designed and ex-

tend the system.

28



Figure 3-2: Calculation settings, selection and control, along with a retractable log
panel.
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3.2 Usage

Herein is presented a complete user documentation of QuintET. Figure (3-2) shows

the calculation settings, selection and control tab, along with the Log panel. The

following few sections will elaborate on the different features of the application.

3.2.1 Settings

All information pertaining to the initial and 'boundary' condition of the universe is

specified here. M 4 is the only fine-tune parameter that needs to be carefully selected

so as the Q selected (refer to figure (3-3)) has the desired value. h, is the Hubble

parameter and is estimated to lie between 0.4 and 1 [8]. (Z + 1)i is set to 10-14

by default for convenience, but can be set as early as the end of inflation [8]. If

Equipartition2 is selected, then equipartition after inflation is assumed and Q[(Z +

1)j], the initial quintessence field strength, is calculated based on that assumption.

Otherwise, Q[(Z + 1)j] must be specified. As discussed previously in this thesis, over

100 orders of magnitude variation in the initial condition of this field are accommodate

for in the quintessence model.

M* -2, IS7718 8 13'94 4 Equbaman i+m

,- 0,65 f AUto ItU M 6"[7-01 E

(Z+0 -) |1,E14 When 7-+1 - 1, set I

@JThWs Evuon 0

Figure 3-3: Initial and 'boundary' conditions. These parameters must be determined
in order to carry out the numerical calculation

An alternative to setting M4 manually, is to have the application determine the

appropriate value by selecting the Auto tune M. In this case, the calculation runs

until whichever initial Q is selected, the application makes sure the absolute value of

2If this is selected, it is crucial that Auto tune M is also selected.
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the difference between the specified value and the calculated value is less than what

is specified in the 6Q[Z = 0] field.

Figure 3-4: Determines which of the two calculations to carry out.

The calculation component that is deployed with this release of QuintET can

carry out two types of calculation. While the first type, Time Evolution, carries out

all calculation based on a specific model for the energy content of the universe, the

second, Wq--Omega Relation, compares W against m for different models, which

can then be compared against astrophysical data.

Time Evolution

In order to carry out Time Evolution calculations, the following three must be set:

what model (or equally what potential), when should calculation end (in redshift),

and which variables to calculate (see figure (3-5)). Seventeen parameters can be

calculated in this mode, and the data can also be displayed directly. Displaying data,

however, is very resources intensive and is disabled by default.

Figure 3-5: Time evolution calculations. From here, one can set the Quintessence
potential and the end calculation parameter as well as which parameters to calculate
and save in memory. Data can be displayed by selecting the appropriate check-box,
however this consumes considerable amount of system resources.
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Wq-Qm

Wq-m calculations are done for different models over a range of Omegam, and for

this reason they take a considerable amount of time to complete. Either or both of

the exponential potential and the inverse power law potential can be selected. For

the inverse power law, the range of the power must also be set. The range of Qm to

use must also be provided in order to carry out these calculations. Finally, the data

can be displayed directly, although this feature is disabled by default.

I se Mt(p[& /Q) j.Range: ( JO 2 T, ) i

Figure 3-6: wq-Qm calculations.

3.2.2 Data

The data generated by the calculation or imported from a file can be directly displayed

in the Data component. Any data source that implements the Iexportable interface

can be displayed here (refer to figure 3-7). The table itself is an extension of the

JTable class (see table (D.1)), enhanced to allow for the requirements of QuintET.

Saving Data

Any column from the data view can be selected by clicking at any given cell, and

multiple columns can be selected by pressing the the "Control" button while selecting

cells of different columns. These selected columns can be saved into a file by either

pressing the "Control" and "s" keys simultaneously or by selecting "Save data" from

the "File" menu. Saving as well as importing of zipped files (see figure (3-8)) is

supported and is recommended when saving/importing a very large set of data.

32



Figure 3-7: Data from calculation or imported from file can be directly displayed and

edited. Data from this view can also be saved by first selecting specific columns-

to select multiple columns, press and hold the "Control" key while selecting cells of

different column-and selecting "Save data" from the "File" menu.
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3.2.3 Plot

The plot component is the most elaborately designed aspect of QuintET. As discussed

below, this component has interfaces for zooming in and out, dragging the axes,

labeling, sampling of data, and many more. The tick mark values are intelligently

calculated to display meaningful numbers. This becomes more complicated since axes

reversing as well as log-linear plotting is supported (see figure (3-9)).

Right-click on the drawing area gives a pop-up window that has a number of use-

ful tools. The first two tools, which are mutually exclusive, enable the dragging and

zooming capabilities. These features are designed to be error tolerant as a number of

unwanted and often unexpected results can happen (out-of-bounds errors for exam-

ple). Following these is the Zoom Level, which extends to give a multiple selection

that change the effect of clicking on the drawing area. Add Text, Clear Last Text

and Clear All Text deal with labeling and adding text to the plot. The following

is a brief discussion of each of these features (see figure (3-10)).

Figure 3-8: If the Zip when saving option is selected, saved data file is zipped.
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Figure 3-9: The plotting interface allows for zooming in and out, dragging the axes,
labeling, etc.
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Figure 3-10: Right-click on the plotting area reveals a pop-up menu with a number
of tools such as selecting either the drag or zoom mode, selecting a zooming level and
labeling tools.

Dragging

If Lock Drag is selected, clicking and dragging the mouse drags the drawing area

along with it. This is very convenient as it allows the user to quickly navigate the

plot to see a specific feature or part of the plot.

Zooming

Zooming, via zoom-box or scaling of the current plot is possible by enabling the Lock

Zoom or choosing from the different Zoom Levels, respectively (see figure (3-10)). If

Lock Zoom is enabled, a left mouse click and subsequent dragging of the mouse while
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the button is still pressed displays a zoom-box (a rectangular area) with one vertex

at the position of the initial click and the diagonally opposite vertex at the current

position of the mouse. If the button is released, the current drawing area axes limits

are set to reflect the zoom-box dimension and location. This features is very powerful

as it allows for a very precise view of the plot under investigation (see figure (3-11)).

Alternatively, if anyone of the five selections under Zoom Level are selected, a

single click on any part of the plot will, first, make the click-point to be the center

of the plot and, secondly, the plot will be scaled according to the selected level. If

the selected level has a scale factor of one, then the plot simply re-centers without

scaling.

Text and Label

Text and labels can be added anywhere in the drawing area. Specifically, x and y

labels can be added and a title can be set using the Add Text tool in the pop-up

(figure (3-10)) menu. The x and y coordinates of the left-top corner of the text to be

displayed is set by default to be the location of the pop-up. This value, however, can

be changed at will from theAdd Text interface. Resizing the window does not alter

where the text is placed, and furthermore the labels and title are always placed in the

correct place regardless what values of x and y are set in the interface. The last text

to be added (regardless if it is a title, label or just text) could be recursively removed,

or alternatively the plot can be cleared off all text by selecting the appropriate button

from the pop-up. See figure (3-12).

Axes Property

Axes setting is another comprehensive design in QuintET. All the basic features

of plotting found in many data visualization tools are supported. The Axes Prop-

erty window is displayed when the corresponding button is clicked (see figure (3-13).

Therein, the scale, data source and (x, y) data, for multiple (x, y)s, are specified. Ei-

ther axis can have a grid, and the limits can be reversed and the scale can either be

log or linear. Data source can either be from the latest calculation (and the selected
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Figure 3-11: In zooming mode, if a mouse is dragged after being clicked (and held
clicked) within the drawing area, a rectangular box (the zoom-box) is displayed.
Upon release of the mouse, the dimensions of the drawing area reflect that of the
zoom-box.

parameters are automatically loaded in the drop-down menu for each axis) or from

an imported data set. The Add>> button adds the selected (x, y) parameter in the

list of to be plotted parameters. Remove All removes all parameters that have been

selected to be plotted, and Clear only removes the recently added parameters to the

list.

Data Sampling

Once the data is selected, it is not plotted right away (nor could it be plotted). It

is often the case that the data contains far more data points than what the current
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Figure 3-12: The Add Text interface. The font, size, location and whether the text
is a label, title is specified here.

display resolution of the monitor could handle. All data sources must first be sampled

according to a density factor that is specific to the height and width of the current

plotting area. Without sampling and for a very dense data, plotting time takes too

long and dragging and zooming becomes a time consuming procedure with limited

benefit. Hence, sampling is enforced for all data source, and each data source must

be of the allowed format for this to take place.

Saving Plot

Saving a plot is straightforward. All saved plots are in PostScript format. The saving

algorithm attempts to do a better job than "what you see is what you get" approach
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Figure 3-13: Here the axes properties are set. Scale corresponds to the limit, scale,
normal-reverse and grid settings while Available Data corresponds to the overall
available data and the selected subset.

by scaling and resampling the data to allow for the most crisp PostScript output.

3.2.4 Miscellaneous

A few items that need a brief discussion are the Menus and the Log component.
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Figure 3-14: Saving plot.
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Menu

The menus, see figures (3-15), (3-16), (3-8), (3-17) and (3-18), have access to some

settings as well as access to the help file. Print preview, page setup, zip when saving

data option, font setting, etc. are accessed from these menus.

Figure 3-15: The QuintET menu interface.

Figure 3-16: The File menu.

Log

The Log, accessible from the calculation, data and plot components, displays any

errors from subprocesses or/and user input. It can be enabled and disabled at will

using the button provided. The Log also accepts keyboard input and can be saved to

file from the File menu.
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Figure 3-17: The View menu.
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Figure 3-18: The help menu.

Figure 3-19: Errors from subprocesses or/and user input log.
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3.3 Future Work

More work needs to be done to increase the versatility of QuintET. In line with the

modularity requirements, additional components can be added for more sophisticated

numerical calculations. Support for multi-format import/export of diagrams and data

is also the next target in the development of QuintET.
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Chapter 4

Conclusion

The development of QuintET took roughly 5 months. During this time, the re-

quirements have changed a number of times. The initial requirement was narrowly

focused on the numerical calculation part, with data visualization done using Mat-

lab. Overtime, however, it was realized that the benefit of having an integrated data

visualization tool justifies the effort.

In Object Oriented development, building user interfaces becomes considerably

simplified. However, a sound and efficient algorithm to handle the real task (nu-

merical integration in this case) is often not given adequate time and thinking. In

the development of QuintET, this issue was addressed by the overall structure of the

user interface, and also by the algorithm developed to handle heavily coupled partial

differential equations.
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Appendix A

Scalar Field-Curvature Coupling

Herein is presented complete derivation, without any restriction on the underlining

space-time, of the solutions to Albert Einstein's field equations. Important final

results are placed inside a box

In the study of scalar field cosmologies, it is very important to study if there is

any significant coupling between scalar fields and gravity. Coupling term such as

1 #02 R (non-minimal coupling) is not excluded theoretically, and since the coupling

gives rise to observational effects, the strength of the coupling parameter, , can be

constrained by observation.

Starting from the action

S = R - 162 1 /IV

=Jd XV'TI= d g $2 R - g""vO,$v + V (O) ]+ SB

= f4Xv'7I [f (O)R - {ig11& qOvO + V(qO)}] + SB , where (A. 1)

f (0) = -- - 0x2) , n = 87rG, (A.2)

R is the Ricci scalar curvature, R = gIvR,,, and SB denotes the action of the back-

ground matter.
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Setting the variation of the action, S, to zero,

S = 0,

the first part of the integral (A.1) gives

6 Jd xJ§ f(O)R = 6f d4xV ZgRpvf ()

= dx ~f/(g"6 R,t, +f d 'xf ()RP

+ f d4xv4g"~Rt,6f ().

Using the geodesic coordinate system to obtain 6R,,, it follows

6RI

-I(v! iggIL)

(A.4)

= 6 raprt, - a Pr + P "T rP - ', 1
A P P O I'P Vl'j

= 6 ,9[app, - , R,, since 6a= 06,

= a, (6rpt) - a,, (6r'P)

= V, (6v",,) (A.5)

where the last step follows directly from the definition of covariant derivative. For

any vector V,, for example, one obtains

VtIV - VVt, = a'4V - aVv.

Since equation (A.5) is coordinate independent, the integrand of the first integral on

the right-hand side of equation(A.4) can be written as,

= -/f ()g" {VP (61PP,)
= vI-f() {VP (g""o6rF,)

- v/ f() {VO (g6i"'a,)

=N/ 9f(#)vcV, I

- V, (6rJ,,) , and since

- V, (g"" ,,) }
- VQ (96L ,,) }

(A.6)
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where

V -- gj-LV 6 - gp"61P.

Using the relation dg = gg""dg,, and by contracting a pair of indices of the

Christoffel symbols, one obtains

-" = ""'Fp, = 19"" 0 ,g

1 1
2Og v/ (A7

With the above result, the covariant divergence of a vector VO can be written as

V, VI = 0 V + FAva a 1- y,) . (A.8)

Consequently, using equations (A.6), (A.7) and (A.8), the first integral on the right-

hand side of equation (A.4) can be rewritten as

I d4 xV/--f()gP"6RJ, d4xf(O), ( Va) , and using integration by parts

= d4xaa {f(q)j VI - I d4 xN/gVaaf ()

- Jd 4xv 7"V f(#) + (vanishing surface term)

= d4x /- gI"6Pof (#) -f d4 xf Ag''6L ",Oaf(q)-9)

From equation(A.7) and the relation dg = ggIvdg,, and , 617P can be rewritten

as

a 1___

, -

+ V/J9 (6V-)

g (v/- .

With this result, the first integral on the right-hand side of equation (A.9) can be
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expressed as

d4xV/ -ggIa61r7p' f() = JdexV { 2 PQa8f(4)0, -g} 6gtw

+Jd4Xgpa&f (O)I,, (6V -) (A.11)

Using integration by parts, the second integral on the right-hand side of equation

(A.11) can be written as

d4 xg paf(q)0, (6v7-) -= / d4xO,, (gp"a&f($)&Z) - d'x0, , f ) 6_g)

9tt} &1V + (vanishing surface (ArA)

Putting equations (A.11) and (A.12) together, the first integral on the right-hand

side of equation (A.9) becomes,

dx V!-g paF,,a f (#) = fd g
{ P a + 10p

= Jd (-g T 6g"',

(g 9f) ghw }glv

(A.13)

where T,, is defined as

T = - gPQOaf(q)&P\/g + 0a, af)] g,. (A.14)

The second integral on the right hand side of equation (A.9) can be simplified by

rewriting -g'J"6F, as,

- d4xIy-g"S , 4

-6 (9Lpa) + Ira 4", therefore

= d xv/7j{FT"0a f ()} 'UV

- J dz4XV/-af(0)6 (gp7) .

The integrand of the second integral on the right-hand side of equation (A.15) can
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be simplified by noticing that

= 9 "' a p g + &Y9pg/ - Op gy)

= glAV gOP (OL9Ptl
I \ )

2 ,g),
using

1an _ _ A

and equation (A.7)

(A.16)- i g" . ea

Finally, using the relation d9 = gg'I"dgjv and equation(A.16),

= o gaO} 6(

2 1
0 {a -gaP} gV g L" +

V1 &9 - - I+ Iv6
VcgL{7g

O1

With this result, the second integral on the right-hand side of equation (A.15) becomes

- d4 xV' qO-af(0)6 (gpv/LQ) = Jdx

+ J d 4xOaf (#)Ov {6

I 
OP

[VI-

[-Zgg ap ]af(4)} 6glV

g"l/]. (A.18)

Using integration by parts, the second integral on the right-hand side of equation

(A.18) becomes

d~x 0af($)av{6V7 g"} JdxOlaf ({)6 [-Vl-g"] - dex&,,f(q)6 [d 7g"L]

= -J dexOf(q)6 -[/ gg"] + (vanishing surface term)

= - d xpaaf(q)gapjVf1- J d xO, 1 0f(q$>)j6g"l

= d4xV/-{-gjwg"P pOaf(q() 3glV

- d1xf-/ {& f(q)}6g&".

Putting equations (A.15), (A.18) and (A.19) together, the second integral on the
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right-hand side of equation (A.9) becomes

- Jdex / g"6',af () - d4 Xv _V { F af () + 2 Lgvap [vg99 ap If(#)

+ 1ypgappOaf(#) - atay (0) 69AV

S d 4x /-g ( T') 6g,", (A.20)

where T is defined as

TA = 2,8Of (#) - 2FI"Oa f (#) - V/g,&p 9A ?gP W 9ap] af g() gAPOpfaf (q).

(A.21)

Finally, the first integral on the right-hand side of equation (A.4) becomes

JdxXV/- I- T1
2 t"V

(A.22)

Using the relation dg = gg""dgj,, the second integral on the right-hand side of

equation (A.4) can be written as

J d xf (q)Rj, (/ Vg w)
= J dx (#)Ryg + J d xf (q)g""R1,6V'7/

= fdxVy-f (O)R,,6g"' - Sd4X I-f()g"PRaP9t,6g "

= d4xVy-{f (#)R,.V -
Igtf (O)R Jgw", since Gj, = RgV -

= d4 x/- {f (#)GQI} 6gw.

Since 6f() is zero, the third integral on the right-hand side of equation (A.4)

vanishes. The variation of the second part of the integral (A.1) leads to the energy-

momentum tensor of a scalar field, as follow:

First defining,

E - g1""VaAa1 + V(#) (A.24)

54

(A.23

1T2 yM.



then it follows,

6 (V Q) = a _ + ag.L ) - gi
6ggAV v AV~ ag

However, the second term of equation (A.25) can be rewritten as

= (0 &(Vg) 6gAw}a (V jLg

Therefore, equation (A.25) becomes

- [(lP )

Using the above result, the second part of the integral (A.1) becomes

61 d 4 x Z/i2L = Jd x{ 0 ( L) g"" + (vanishing surface term)

= d 4x

where T, is defined as

T3,) jgp",

T3 2 f (V-_gC)
1W & 7gILV

Since L doesn't depend on ga"', T, becomes

T3, = O,#&, - igm (g POa#ap + 2V(#)).

Finally, using equations (A.22), (A.23) and (A.27), equation (A.3) becomes

6S = fd xV If ())G,1 - TI - T2
2 11V

Tl T}6g" = 0,2 T3

where T, is the energy-momentum tensor of background matter. Since equation

(A.30) is valid for an arbitrary variation 6g'"', the integrand must be equal to zero.
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Therefore,

G" 2f() T" +T2±+T +T B

G,1 = KT7P , (A.31)

where T,, the effective energy-momentum tensor, is given by

T1 (1 - Eq$2 ) 1 [T, +T,2,+T,+T . (A.32)

To illuminate the consequences of the coupling term, equations (A.31) could be

rewritten as

= Ief [TA,+ T2, + T + TB, (A.33)

where
__ 1 --1

Keff f - - 2 . (A.34)
2f(q$)

Therefore, the value of can be constrained by the measured time variation, or

lack thereof, of the Newton's constant. Using solar-system measurements [5] have

determined that 11 < 10-2. My numerical calculations show that this coupling has

insignificant consequences as long as the evolution of the universe is concerned.
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Appendix B

Equation of Motion of the Scale

Factor R

Herein is presented a full derivation of the equation of motion of the scale factor R.

The zero curvature k = 0 Robertson-Walker metric takes the form

ds 2 = -dt 2 + R 2 (t) (dx2 + dy 2 + dz2) . (B.1)

For the metric (B.1), the only non-zero terms of the connection coefficient are:

Fl = Fr2 = 3

]Pi = ]PO = ]PO

1 ~
= 39ii,o

and terms related by the symmetry F = F.

Therefore, the only non-zero terms of the Ricci tensor, which will be denoted Ric

from here on, are

Ric,, = Ric22 = Ric33

Ricoo

= F11, 0+ 101 0 = 2 2 + RR

= -3 301,0 + (110 )2]
= -3 (f + H2) .
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Hence, the Ricci scalar curvature becomes,

Ric = gl"Ric,, = 3 (f + 3H2 + )= 6 ( + 2H2),

where the last step follows directly from

at ) - -
R

Using these results, equation (A.31) gives

Goo

H 2

1
= Ricoo - IgooRic

2

- -3(f+H2)+3(H+2H2)

= 3H 2 = KTOO, therefore

3Too.3

Furthermore, the spatial components give

Gi = G22= G33

1
= Ricl - Ig, Ric = 21?2 + Rbt - 3R 2 +

- ft 2 - 2R = iT1 .

Dividing equation (B.9) by R 2 and using equation (B.8)

[R 2 (rT 1 + ( )2]R +
R- (-Rxn)

- R-2(T 11) + Too

- [Too + 3R-2T]

Putting equations (B.8) and (B.10) into equation (B.7) gives

H = -[JToo + 3R 32T Too
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= - [T + R-2T 1 ]. (B.11)

What is there left to do is to evaluate both Too and T11 . Before proceeding any

further, it pays to investigate what restrictions are imposed on T B by the assumption

that the space-time is isotropic. In short, the energy-momentum tensor of the matter

can be written in the form

TI" = PB9 + (PB + PB) UPUV, (B.12)

where u/' is a unit vector in the time direction and PB and PB are the energy density

and pressure of matter, respectively.

Starting from Too (keeping in mind that v/7g = R3)

- af(q) &R3  a 2 f(q)

- {3H at + 0t2 , (B.13)

a2f () R-3_ f() aR3 
- 02f()

T010= at2 - t at at2

_ 2f () - 3H 0 f7() (B.14)
at2 at'

-0 2 + V(#), and (B.15)

T = PB- (B.16)

Putting equations (B.13), (B.14), (B.15) and (B.16), and the following first and

second time derivatives of f(0),

at_ -(B.17)

2 () 2 + #),(B. 18)at2

in equation (A.32), Too becomes,

= (1 - 6r02 - PB + 2 + V(#) + 66HqOk}. (B.19)
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Similarly, starting from Ti\,

Tf - R-3f(#) OR 3  02f(q)
at at at2

= R2 3H + ,

= -21 1  +

= -2RR +at

R R(Hq2t +

= R2 - 2 (t) - V

= R 2PB-

at
3RR

at

at2 JI

and

+ R2 af (0)t2

at2

(B.21)

(B.22)

(B.23)

Finally, using equations (B.17) and (B.18), (B.20), (B.21), (B.22) and (B.23), T11

becomes,

- 02 R1R2 PB+ 2 - V(4)+4H a +2 a 2

K0= (1 - 2 R 2 {PB + 1 ! 2 - V($) - 4H #q - 2 ( 2 + 4s) } (B.24)

Finally, substituting equations (B.19) and (B.24) for Too and T11 , respectively, in

equations (B.8) and (B.11), gives

H2  2)-1 PB + 1 $2 + V() + 6cHqOq ,

H= -(1PB +PB + +2+2 (Hq$ - q 2 - .

(B.25)

(B.26)
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Appendix C

Equation of Motion for q

Herein is presented the full derivation of the equation of motion of scalar fields, #,

with a none-zero scalar field-curvature coupling term.

The only term of the action (A.1) that could depend on # and o9q#, after multi-

plying through by -1, are

S = J 2 [q2R + g" 0 O + V(#). (C.1)

Setting the variation of the above action to zero,

JS = 0, (C.2)

and defining

L = R 2 + g1"8a#oa4 + V(# ), (C.3)

it follows

6 (/c-gL) 09q5
+ (v7_LD 6 (09#)

+ A 0#)

However, the second term of equation (C.4) can be rewritten as

9 (V 7 Z) j(Pao)
09 A i') act "{( a#) 60

( (a ).
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Therefore, equation (C.4) becomes

o( I-gC)= q
a(Pao) )

Using the above result, the variation of the action (C.1) becomes

61 d4 xVI2 - I
=1

d x

d-gx

09

-0 a (N1vZTL)
- Da A)

}6q + (vanishing surface term)

}O = 0. (C.6)

Since equation (C.6) is valid for an arbitrary variation JO, the integrand must be

equal to zero. Therefore,

a Oq__IC -c, ( aAO) ) =0. (C.7)

For the metric (B.1) and i8q$ = 0, where i = (1, 2,3), equation (C.7) gives

R3{6 (k+2H2)#+V'(#)}

*R3 {6 (k + 2H 2) + V'(#)}

= OtR3
0 0 q,0 (9t# R3 O _ R3 &0 ( )+ Pao)

= 3R2R j+R3at

= -3R21y - R 3, (C.8)

where prime indicates the partial derivative with respect to #. Therefore,

(C.9)

The above derivations were presented for the sake of completeness. For reasons dis-

cussed in chapter 2, ~ 0 is assumed in this thesis.
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Appendix D

Java 2 SDK Packages
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Package Name Description
Contains the collections framework, legacy collection
classes, event model, date and time facilities, interna-

java.util tionalization, and miscellaneous utility classes (a string
tokenizer, a random-number generator, and a bit array)

java.util.zip Provides classes for reading and writing the standard ZIP
and G7JP file formats
Provides classes and interfaces for handling text, dates,

java.text numbers, and messages in a manner independent of nat-
ural languages
Provides for system input and output through data

javadio streams, serialization and the file system
Provides classes for performing arbitrary-precision inte-

java.math ger arithmetic (BigInteger) and arbitrary-precision deci-
mal arithmetic (BigDecimal)
Contains all of the classes for creating user interfaces and
for painting graphics and images
Provides interfaces and classes for dealing with different
types of events fired by AWT components
Provides the Java 2D classes for defining and performing

java.awt.geom operations on objects related to two-dimensional geome-
try

java.awt.print Provides classes and interfaces for a general printing API
Provides a set of "lightweight" (all-Java language) com-

javax.swing ponents that, to the maximum degree possible, work the
same on all platforms
Provides classes and interface for drawing specialized bor-
ders around a Swing component

javax.swing.event Provides for events fired by Swing components
Provides classes and interfaces for dealing with

javax.swing. table javax.swing.JTable

javax.print Provides the principal classes and interfaces for the Ja-
vaTM Prit Service APTI
Provides classes and interfaces that describe the types of

j avax. print. attribute JavaTM Print Service attributes and how they can be
collected jnto attribute sets

tattibttdd Package javax.print.attribute.standard contains classes
for specific printing attributes

Table D.1: Primary Java 2 SDK
tET.

Packages [10] employed in the development of Quin-
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